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[bookmark: _Toc287553853][bookmark: _Toc320197570]Introduction
The Patient Assessment Documentation Package (PADP) Version 1.0 is a Veterans Health Information Systems and Technology Architecture (VistA) software application that enables Registered Nurses (RNs) to document, in a standardized format, patient care during an inpatient stay. Although the content is standardized for use across the VA system, some parameters can be set to support the unique processes at individual medical centers. 

PADP interfaces directly with several VistA applications, including Computerized Patient Record System (CPRS), Clinical Reminders, Consult Tracking, Allergy/Adverse Reaction Tracking, Mental Health Assistant, Vitals, and Patient Care Encounter (PCE). 

PADP is a Delphi application, which supports RNs in documenting patient care during an inpatient stay. It includes the following templates:  
Admission – RN Assessment allows RNs to document the status of the patient at admission.
Admission – Nursing Data Collection allows Licensed Practical Nurses (LPNs) and other nursing staff, including the RN, to enter basic patient data, such as vitals and belongings at the time of admission.
RN Reassessment allows RNs to document the condition of the patient on a regular basis and any time during the inpatient stay. 
Interdisciplinary Plan of Care interfaces with admission and reassessment data, and allows additional information to be entered by the RN and other health care personnel (physicians, social workers, chaplain, etc.). All clinical staff can enter information into the Plan of Care. The Plan of Care can be printed and given to the patient when appropriate.

PADP consists of a KIDS build, NUPA 1.0, and four (4) Delphi GUI templates in three executables. 
The executable, Admassess.exe, contains the Admission - RN Assessment template and the Admission - Nursing Data Collection template.
The executable, Admassess_Shift.exe, contains the RN Reassessment template.
The executable, Admassess_Careplan.exe, contains the Interdisciplinary Plan of Care template.

Each template is associated with a note. 
The Admission - RN Assessment template is associated with the note: RN Admission Assessment 
The Admission - Nursing Data Collection template is associated with the note: Nursing Admission Data Collection
The RN Reassessment template  is associated with the note: RN Reassessment
The Interdisciplinary Plan of Care template is associated with the note: Interdisciplinary Plan of Care

PADP adds to VistA, a new namespace (NUPA), four (4) Progress Notes, five (5) printouts, fourteen (14) files, thirty-six (36) parameters, and new health factors. The 5 printouts are:
1. The Daily Plan® is a health summary designed to be given to the patient and family
Plan of Care is a plan designed to guide the nursing staff
Discharge Plan is for discharge planners
Belongings is a list of patient belongings
Safe Patient Handling is designed to guide the transfer of a patient


[bookmark: _Toc286401057][bookmark: _Toc320197571]Using Admission – Nursing Data Collection
The Data Collection tabs contain information that is collected by any nursing personnel. This information is located on tabs: Belongings, Orientation to the Unit, and Vital Signs.
[bookmark: _Toc320197572]Opening Admission – Nursing Data Collection
You access the Admission -Nursing Data Collection through CPRS from the Tools menu.
1. Open CPRS.
Select a patient.
Click Tools.
Select Data Collection.
Enter a patient window automatically opens to the CPRS patient.
Note: You may have to re-enter your CPRS access and verify codes, depending on local site setup.
[image: ]
Access through CPRS





[bookmark: _Toc320197573]No Previously Saved Information
The Enter a patient window displays.
[image: ]
Admission – Nursing Data Collection, Enter a patient window with no previously saved information
1. Select an Assessment Type.
Click Start Note.
The nursing data collection template opens to the Belongings tab for the CPRS patient.
[bookmark: _Toc320197574]Previously Entered Information Available for One Patient
[image: ]
Patient selection window with previously entered information available for one patient
[bookmark: _Toc320197575]Restore Patient’s Data/No
If you previously entered data on one patient, you are prompted with: You have previously saved data on a note for patient <PADPPATIENT,ONE >
1. Select an Assessment Type.
1. Select No.
The patient’s information is deleted, but the Internal Entry Number (IEN) for the patient displays in the Enter a patient text box.
Click Start Note.
The template opens to the Belongings tab and you can enter new data for that CPRS patient.
Optional: You can delete the IEN of that CPRS patient, enter the name of a different patient, and click Start Note.
Note: The Internal Entry Number (IEN) is a unique, computer-generated number that identifies a specific patient in your system. The IEN has no impact on the completed assessment, nor does it display again.
[bookmark: _Toc320197576]Restore Patient’s Data/Yes
If you previously entered data on one patient, you are prompted with: You have previously saved data on a note for patient <PADPPATIENT,ONE >
1. Select an Assessment Type.
Select Yes.
Click Start Note.
The template opens to the Belongings tab for the CPRS patient with the data restored.
[bookmark: _Toc320197577]Previously Entered Information Available for Two or More Patients
If you have previously stored data from more than one patient, you are asked if you want to view a list of those patients.
[image: ]
Patient selection window with previously entered information available for more than one patient
[bookmark: _Toc320197578]View the Patients?/No
If you select No, the patient’s name displays in the Enter a patient text box as a number that identifies the CPRS patient.
1. Select an Assessment Type.
Click Start Note. 
The template opens to the Belongings tab.
[image: ]
Patient selection window with No selected
[bookmark: _Toc320197579]View the Patients?/Yes
1. Select Yes.
Select an Assessment Type.
Patient Selection window displays with a list of patients with saved data.
[image: ]
Patient Selection List
[bookmark: _Toc320197580]Patient on the List
1. Select a name.
Click OK. 
The template opens to the Belongings tab.
[bookmark: _Toc320197581]Patient not on the List
1. Click Cancel.
The number that represents your CPRS patient is in the Enter a patient text box. 
Click the Start Note. 
The template opens to the Belongings tab.

[image: ]
Admission – Nursing Data Collection, Belongings (Belong) tab window, Bel Page 1
[bookmark: _Toc320197582]Patient not yet Assigned to an Inpatient Bed
When a patient is not assigned an inpatient bed, a location pop-up automatically displays over the Belongings window.
[image: ]
Location pop-up: Select visit location 
1. Select a current patient location, i.e., outpatient clinic.
Navigate quickly to the current location by entering the first letter of the location.
Click OK.
[bookmark: _Toc320197583]
Saving and Uploading Data
[bookmark: _Toc320197584]Auto Save
Data are saved automatically. Frequency of auto save is set locally. 
[image: ]
Saving data: percentage saved indicator
(bottom right corner of the window)
[bookmark: _Toc320197585]Manual Save
You can save data by using the File menu on any tab.
[image: ]
Admission – Nursing Data Collection window, File menu
[bookmark: _Toc320197586]Upload Data
To create a note you must upload the data into VistA and CPRS: 
1. Open the File menu on any tab and select Upload Data.
Results from your upload display, verifying that the data is uploaded.
[image: ]
Admission – Nursing Data Collection, Upload results window
Note: The unsigned note, selected consults, and PCE data/Health Factors are uploaded into CPRS and VistA.
If the information is incomplete, an Error Listing window displays indicating the pages within specific tabs that require attention. 
The tabs with pages that require attention are blue.
[image: ]
Admission – Nursing Data Collection, Error Listing window
Once the pages are completed, the tab returns to gray.
1. Double-click an item to go to the page that requires attention.
When all the errors are completed, select Upload Data again.
[bookmark: _Toc320197587]Save and Exit
To save data and temporarily leave the template:
1. Open the File menu on any tab.
Select Save and Exit.
When you re-open the template, your previously entered data is there.
[bookmark: _Toc320197588]Save Now
To save data, but not close the template and continue to enter data:
1. Open the File menu on any tab.
Select Save Now.
Continue to enter data for the current patient.


[bookmark: _Toc320197589]Exit 
1. From any tab, click X in the top right corner of the window.
Warning message displays.
[image: ]
Warning pop-up: Do you really wish to exit?
Click Yes.
From any tab, open the File menu and click Exit.
Warning message displays.
Click Yes.
[bookmark: _Toc320197590]Signing Notes
Go to CPRS to sign your uploaded, unsigned notes.

You can also sign unsigned notes after the upload from the View Text tab in the template.
1. Click View Text.
[image: ]
Admission – Nursing Data Collection, View Text tab after upload


Click Sign Note/Consults.
[image: ]
Admission – Nursing Data Collection with Sign Note/Consults button
Enter your electronic signature and click Accept e-sig.
To prevent the signing of an uploaded note, click Cancel e-sig.
[bookmark: _Toc320197591]Working in the Template
1. To complete the template, move through the fields from left to right and then down.
The active page displays first and the page tab is white.
Each field with an asterisk (*) must have an entry. 
A field without an asterisk is optional. 
You must enter optional information where appropriate for the patient.
[bookmark: _Toc287826016][bookmark: _Toc320197592]Moving through the Template with a Mouse
1. Click a tab at the bottom of any of the Admission - Nursing Data Collection windows.
The selected tab opens.
[image: ]
Admission – Nursing Data Collection tabs


Open the Tabs menu and select a tab from the list.
The selected tab opens.
[image: ]
Admission – Nursing Data Collection Tabs menu
[bookmark: _Toc283040082][bookmark: _Toc320197593][bookmark: _Toc242249228][bookmark: _Toc254691273]Moving through the Template without a Mouse
[bookmark: _Toc283040083][bookmark: _Toc320197594]Ctrl-Alt Keys
You can move from tab to tab using Ctrl+Alt+<letter>. The list contains the keys to use for each of the tabs.

	Tab
	Keys

	Belongings
	Ctrl+Alt+B

	Orientation
	Ctrl +Alt+O

	Vital Signs
	Ctrl +Alt+U

	View Text
	Ctrl +Alt+V





[bookmark: _Toc320197595]Go to radiogroup
The Go to radiogroup: is designed to navigate the templates with keyboard commands, when the mouse stops working during a patient assessment. It also satisfies the 508-compliant requirement, under Section 508 of the Rehabilitation Act, to be able to navigate the templates without using a mouse. 
[image: ]
Go button
1. Use the Tab key to move to the bottom of the page.
Use the arrow keys to move up/down in the Go to radiogroup: list.
Click Go.
or
1. Click the drop-down arrow in the Go to radiogroup: drop-down list.
Select a radiogroup.
Click Go.




[bookmark: _Toc320197596]
Navigating the Admission - Nursing Data Collection Tabs
The Admission – Nursing Data Collection template has four tabs. It can be part of the Admission – RN Assessment template or as a standalone template.
[bookmark: _Toc320197597]Belongings (Belong)
The Belongings tab contains information about items the patient brought to the hospital, disposition of the items, and items that the patient took home.

1. Admission – Nursing Data Collection opens to the Belongings (Belong) tab, Bel Page 1. 
[image: ]
Admission – Nursing Data Collection, Belongings (Belong) tab, Bel Page 1 window
Does patient have items to inventory/Not at this time
[image: ]
Admission – Nursing Data Collection, Belongings (Belong) tab, Bel Page 1 window
Does patient have items to inventory/Yes
Populate Bel Page 1.
Select Yes or No in the Does patient have items to inventory radiogroup.
If you select No, go on to another tab.
If you select Yes, additional fields are made available. 
1. Make appropriate selections on Bel Page 1.
Click Print to print the page.


Click Bel Page 2.
Bel Page 2 displays.
[image: ]
Admission – Nursing Data Collection, Belongings (Belong) tab, Bel Page 2 window
Populate Bel Page 2.
Complete all the fields with asterisks; they are required fields.
Click Print to print the page.


Click Bel Page 3.
Bel Page 3 displays.
[image: ]
Admission – Nursing Data Collection, Belongings (Belong) tab, Bel Page 3 window
Populate Bel Page 3.
1. Complete all the fields with asterisks; they are required fields.
Click Print to print the page.


Click Bel Page 4. 
Bel Page 4 displays.
[image: ]
Admission – Nursing Data Collection, Belongings (Belong) tab, Bel Page 4 window
Populate Bel Page 4.
1. Complete all the fields with asterisks; they are required fields.
Click Print to print the page.


[bookmark: _Toc242249230][bookmark: _Toc254691274][bookmark: _Toc320197598]
Orientation to Unit (Orient)
The Orientation to Unit tab allows you to indicate the unit areas to which you oriented the patient.
1. Click Orient.
Orient window displays.
[image: ]
Admission – Nursing Data Collection, Orientation to Unit (Orient) tab window
In the Patient/family/support person oriented to unit list box, select:
Yes-patient oriented to unit or
Yes-family/support person oriented to unit
No-patient unable to respond
No family/support person available
Oriented to list box displays with a list of orientation activities.
[image: ]
Admission – Nursing Data Collection, Orientation to Unit (Orient) tab window
Yes-patient oriented to unit

[bookmark: _Toc242249229][bookmark: _Toc254691275][image: ]
Admission – Nursing Data Collection, Orientation to Unit (Orient) tab window
Yes-family/support person oriented to unit
[image: ]
Admission – Nursing Data Collection, Orientation to Unit (Orient) tab window
No-patient unable to respond
[image: ]
Admission – Nursing Data Collection, Orientation to Unit (Orient) tab window
No family/support person available
In the Oriented to list box, select one or more areas to which you oriented the patient.

[bookmark: _Toc320197599]
Vital Signs (V/S)
The Vital Signs tab allows you to document the patient’s vital signs at admission. The vital signs include temperature, pulse, respiration, blood pressure, height, weight, pain, pulse oximetry, and circumference /girth. 
Note: When you click Upload Vitals, vital signs are uploaded immediately into the Vitals package.
[image: ]
Admission – Nursing Data Collection, Vitals (V/S) tab window
1. Click V/S. 
V/S displays.
1. Complete all the fields with asterisks; they are required fields.
[bookmark: _Ref272770431]Click each Click to enter qualifiers, to select qualifiers for each of the vitals.
Note: Remember to enter units where appropriate. 
Example
Entering the temperature, depending on the type of thermometer used, select C for Centigrade or F for Fahrenheit.
Entering the height and weight, depending on the instruments used, select CM or IN and KG or LB.
[image: ]
Admission – Nursing Data Collection, Vitals (V/S) tab window, Qualifiers - Temp
[image: ]
Admission – Nursing Data Collection, Vitals (V/S) tab window, Qualifiers - Pulse
[image: ]
Admission – Nursing Data Collection, Vitals (V/S) tab window, Qualifiers - Resp
[image: ]
Admission – Nursing Data Collection, Vitals (V/S) tab window, Qualifiers - BP
[image: ]
Admission – Nursing Data Collection, Vitals (V/S) tab window, Qualifiers – Height
[image: ]
Admission – Nursing Data Collection, Vitals (V/S) tab window, Qualifiers - Weight

[image: ]
Admission – Nursing Data Collection, Vitals (V/S) tab window, Qualifiers – Pulse Ox
[image: ]
Admission – Nursing Data Collection, Vitals (V/S) tab window, Qualifiers - Circumference
[bookmark: _Ref272770450]

Click Save Qualifiers, after selecting qualifiers for the individual vitals.
To remove incorrect qualifiers entered in error, click Cancel before saving.
Click Upload Vitals.
Information pop-up displays.
[image: ]
Information pop-up: Vitals will now be uploaded.
Click OK.
Information pop-up displays.
[image: ]
Information pop-up: Vitals uploaded!
Click OK.
[image: ]
Admission – Nursing Data Collection, Vitals (V/S) tab window with Qualifiers
If you select the Vitals cannot be taken at this time or the patient refused check box, 
enter a reason in the *Why were vitals not taken text box in the lower left corner of the page.
[image: ]
Admission – Nursing Data Collection, Vitals (V/S) tab window
Vitals cannot be taken at this time or patient refused
If you select the Could not obtain height and/or the Could not obtain weight check boxes at time of assessment, enter a reason in the *Why were vitals not taken text box in the lower left corner of the page.
[image: ]
Admission – Nursing Data Collection, Vitals (V/S) tab window
Could not obtain height/Could not obtain weight

[bookmark: _Toc320197600]View Text (View Text)
The View Text tab is a review of all the information entered for a patient during data collection.
[image: ]
Admission – Nursing Data Collection, View Text Tab, after Upload
1. Click View Text.
The View Text window scrolls through the data collection for review.
Review the patient data.
Open the File menu and select Upload Data.
Upload results window displays.
[bookmark: _Toc287826058][bookmark: _Toc320197601]Signing Note and Consults from within the Template
Note: Manage consults according to medical center policy. If nurses at your site do not order consults, upload a mandatory consult, but do not sign it. 
The identified provider will be notified that there is a consult to sign.
You can sign unsigned notes after the upload from the View Text tab in the template.
1. Click Close on the Upload results window.
Sign Note/Consults button displays.
[image: ]
Admission – Nursing Data Collection with Sign Note/Consults button
Click Sign Note/Consults.
If the button does not display, upload again.
[image: ]
Admission – Nursing Data Collection with Sign Note/Consults button
Note: If there is only a note to sign, the button is Note.
If there is a consult to sign, the button is Sign Note/Consults.
Enter your electronic signature code and click Accept e-sig.
Information pop-up displays, Note signed!.
Click OK.
To prevent the signing of an uploaded note, click Cancel e-sig.
Note: It is safer to go to CPRS, read the note in CPRS, and sign the note in CPRS. 
An unsigned note can be edited. 
A signed note cannot be edited.


[bookmark: _Toc320197602]Glossary
	Term
	Definition

	ADPAC
	Automated Data Processing Application Coordinator

	ART
	Adverse Reactions Tracking

	BCE
	Bar Code Expansion

	BCE-PPI
	Bar Code Expansion-Positive Patient Identification

	BCMA
	Bar Code Medication Administration

	Belong
	Belongings

	CAC
	Clinical Application Coordinator

	CIWA
	Clinical Institute Withdrawal Assessment.--CIWA

	Class 1 (C1)
	Software produced inside of the Office of Enterprise Development (PD) organization

	Class 3 (C3)
	Also known as Field Developed Software 
Refers to all VHA software produced outside of the Office of Enterprise Development (PD) organization

	CMS
	Centers for Medicaid and Medicare Services

	COTS
	Commercial Off the Shelf

	CP
	Care Plan

	CPRS
	Computerized Patient Record System

	CV
	Cardiovascular Assessment

	Delphi
	Programming language used to develop the CPRS chart

	DFN
	Data File Number

	DP
	Discharge Planning

	Educ
	Educational Assessment 

	Func
	Functional Assessment

	Gen Inf
	General Information tab

	GI
	Gastrointestinal Assessment

	GU
	Genitourinary Assessment

	GUI
	Graphical User Interface

	ICD
	International Classification of Diseases

	ICN
	The patient’s national identifier, Integration Control Number 

	IDPA
	Interdisciplinary Patient Assessment - involves multiple disciplines responsible for assessing the patient from their perspective and expertise.

	IDPC
	Interdisciplinary Plan of Care -  The entry of treatment plans by multiple disciplines to meet JCAHO requirements

	IV
	Intravenous

	IV Central
	Central IV lines

	IV Dialysis
	IV Dialysis ports

	IV Periph
	IV Peripheral lines

	JCAHO
	Joint Commission on Accreditation of Healthcare Organizations 

	LPN
	Licensed Practical Nurse

	M/S
	Musculoskeletal Assessment

	MAS
	Medical Administration Service

	MH
	Mental Health Assessment

	MRSA
	Methicillin-Resistant Staphylococcus Aureus

	NAA
	Nursing Admission Assessment 

	Neuro
	Neurological Assessment

	NHIA
	Nursing Healthcare Informatics Alliance

	NPAT
	National Patient Assessment Templates

	NUPA
	Namespace assigned to  the Patient Assessment Documentation Package (PADP) by Database Administrator

	OED
	Office of Enterprise Development

	OERR
	Order Entry Results Reporting

	OIT
	Office of Information and Technology

	ONS
	Office of Nursing Services

	Orient
	Orientation to Unit

	P/S
	Psychosocial Assessment

	PADP
	Patient Assessment Documentation Package 

	Pain 
	Pain Assessment

	PC
	Plan of Care

	PCE
	Patient Care Encounter

	PD
	Product Development

	PHR
	Patient Health Record

	Prob
	Problems/Interventions/Desired Outcomes tab in the RN Reassessment

	Resp
	Respiratory Assessment

	Rest (or Restr)
	Restraints

	RN
	Registered Nurse

	RPC
	Remote Procedure Call

	RSD
	Requirements Specification Document

	Section 508
	Under Section 508 of the Rehabilitation Act, as amended (29 U.S.C. 794d) Public Law 106-246 (http://va.gov/accessible) agencies must provide employees and members of the public who have disabilities access to electronic and information technology that is comparable to the access available to employees and members of the public who are not individuals with disabilities

	Skin
	Skin Assessment

	SNOMED – CT
	Systemized Nomenclature of Medicine Clinical Terms

	TIU
	Text Integration Utilities Program
All text in CPRS is stored in TIU

	TJC
	The Joint Commission

	V/S
	Vital Signs

	VA
	Department of Veterans Affairs

	VAMC
	Department of Veterans Affairs Medical Center

	VANOD
	VA Nursing Outcomes Database

	VHA
	Veterans Health Administration

	VistA
	Veterans Health Information Systems and Technology Architecture
An enterprise-wide information system built around an electronic health record used throughout the Department of Veterans Affairs medical system.

	Vital Qualifiers
	Provide detail in to the unit of measurement used with the vital signs.  
Height in inches or centimeters?  
Weight in pounds or kilograms?



For additional PADP information, refer to the user manuals for Admission – RN Assessment, RN Reassessment, and Interdisciplinary Plan of Care.

Documentation for NUPA Version 1.0 is also available on
VA Software Documentation Library in the Clinical Section 
http://www4.va.gov/vdl/
PADP SharePoint for NUPA Version 1.0 http://vaww.oed.portal.va.gov/programs/class3_to_class1/padp/field_development
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